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Introduction

This set of laboratory works is aimed at providing students with systematic
practical training in modern computer-aided design (CAD) using the SolidWorks
software package. The course is focused on the development of skills in three-
dimensional modeling of parts, preparation of technical drawings, and implementation
of engineering analysis with integrated SolidWorks modules. Such competencies are
essential for future engineers in the fields of mechanical engineering, hydropower, and
related industries.

The laboratory course includes four works that gradually guide students from
the basics of 3D part modeling to advanced analysis tasks.

In the first laboratory work, students learn to build solid models of parts in
SolidWorks based on traditional engineering drawings.

The second work introduces parametric modeling principles through the
construction of a membrane model, emphasizing the use of sketching tools and
geometric relations.

The third laboratory work focuses on creating a 3D model of a shaft and
preparing its complete technical drawing, consolidating skills in building assemblies
and applying standards of engineering graphics.

Finally, the fourth laboratory work is devoted to strength analysis of a part using
the SolidWorks Simulation module, where students perform static calculations and
assess the stress-strain state and safety factor of the modeled component.

By completing these laboratory works, students will strengthen their theoretical
knowledge of engineering graphics and computer modeling, while gaining practical
experience in CAD tools that are widely used in design offices and industrial
enterprises.

Mastery of SolidWorks functions, from modeling to engineering analysis, will
significantly enhance their professional competencies and prepare them for solving

real engineering problems in their future careers.



Lab Work Nel: Building solid models of parts in the SolidWorks

environment based on drawings

1. General provisions

Laboratory work is carried out within the framework of studying the discipline
dedicated to computer modeling of parts in modern computer-aided design (CAD)
systems. The main goal of this work is to develop practical skills in students to create
three-dimensional solid-state models of parts according to the provided drawings using
the SolidWorks software package.

SolidWorks is one of the leading computer-aided design systems that allows
you to model both individual parts and assembly units, create design and construction
documentation, perform engineering strength calculations, flow analysis, and other
technological tasks.

As part of this laboratory work, each student receives an individual version of
the task. The versions include a set of drawings of parts of varying geometric
complexity. The student's task is to create a solid model of the part in the SolidWorks

environment according to the provided dimensions and drawing requirements.

2. Theoretical part

2.1. General information about solid modeling

Solid modeling is the process of creating a computer model of an object that has
fully defined geometry, mass, material properties, and precise dimensions. Unlike
wireframe or surface modeling, a solid model is a complete virtual analogue of a real
part.

SolidWorks provides a wide range of capabilities for creating solid models from
2D sketches and applying a variety of solid modeling operations to them. These
operations include:

« Extrude Boss / Base (Extrude Body) — Create a solid body by extruding the

sketch in a perpendicular direction.



« Revolve — creates a body of revolution based on a sketch, rotated around a

specified axis.

steps:

o Cut- Extrude — creating through or blind holes and slots.

o Fillet and Chamfer — processing corners and edges of parts.

2.2. Basics of working in SolidWorks

The process of creating a solid model in SolidWorks includes several main

1. Creating a new part — opening a new file in *.SLDPRT format.
2. Select the base plane (Front plane, Top plane, Right plane).

3. Sketching — creating a 2D profile of the future body.

4. Applying dimensions and relationships in a sketch.

5. Using solid modeling operations.

6. Adding auxiliary elements — cutouts, holes, chamfers, roundings.
7. Checking the geometry against the drawing.

8. Saving the model in .SLDPRT and .STEP formats .

3. Procedure for performing the work

1. Get acquainted with the individual version of the task, which includes a

drawing of the part with all the necessary dimensions.

2. Identify the main operations that will be used to create the model.
3. Open a new part file in SolidWorks.
4. Select the base plane for the first sketch (Front Plane, Top Plane or Right

Plane).

5. Build a sketch according to the drawing - the profile of the future part.

6. Apply the required dimensions (Smart Dimension) and relationships

(Relations) to make the sketch fully defined.

part.

7. Perform an extrusion or rotation operation to obtain the basic shape of the



8. Create additional elements (holes, grooves, cutouts) using additional
sketches.

9. Add fillets or chamfers on the corresponding faces.

10. Check that the resulting model matches the drawing.

11. Save the part in SLDPRT and STEP format.

12. Prepare a report with attached screenshots of the main stages of modeling.

4. Requirements for preparing a report

The report must contain:

« Title page (discipline name, option number, student's last name and group).
« The purpose of the work.

« Description of the execution sequence.

 List of tools and commands used.

« Screenshots of all key stages of model building.

« Images of the finished 3D model in three standard views.

« Conclusions on the work performed.

Conclusion

This laboratory work allows students to acquire skills in creating three-
dimensional models of parts from drawings, which is a mandatory component of the
professional training of future mechanical engineers and specialists in the field of
hydropower. Mastery of SolidWorks tools and the ability to analyze drawings are
important competencies for work in modern design offices and production

departments.



Lab Work Ne2: Creating a 3D model of a flat membrane using SolidWorks

Introduction

In this laboratory work, students will get acquainted with the basics of
parametric modeling in SolidWorks — a modern CAD system that is widely used to
create three-dimensional models in mechanical engineering, design and other
industries. The work involves the development of a fully defined sketch of a flat
membrane, which is the basis for creating a 3D model using the Extrude operation. In
addition, students will gain practical skills in working with tools such as Circular
Sketch Pattern (Circular sketch array), Mirror (Mirror image), Straight Slot, Polygon,
Trim Entities (Trimming) and others. It is also intended to use the Fillet command to
smooth the edges of the model.

The development of this part is aimed at consolidating practical skills in
working with SolidWorks, since the correct construction of sketches is a key stage in
the creation of any three-dimensional element. The sketch is the foundation on which
the entire subsequent model is based, so it is important to be able to use the entire set

of SolidWorks functionality to obtain fully defined geometry.

1. Purpose of the work
The purpose of this laboratory work is to develop practical skills in working
with the SolidWorks program, in particular:

« Mastering the principles of building fully defined sketches using dimensions
(Smart Dimension) and geometric dependencies (Relations), which are the basis
of parametric modeling.

o Gaining the skills to create simple three-dimensional bodies based on 2D
sketches using the Extrude operation.

« Using additional tools to optimize sketch construction, such as Circular Sketch
Pattern (Circular sketch array), Mirror (Mirror image), Straight Slot, Polygon,
and Trim Entities (Trimming), which allows you to quickly create repeating and

symmetrical elements.



Developing skills in creating fillets on the edges of a 3D model, which improves
the functionality of the part and its aesthetic appearance.

Developing skills in drawing up a simple drawing of a part, which is important
for further production documentation.

Preparation of a report in which the student will describe in detail all the stages
of constructing a sketch, creating a 3D model and drawing, as well as analyze

the results obtained and draw conclusions regarding the quality of the task.

2. Theoretical foundations of working in SolidWorks

SolidWorks is a parametric modeling system that allows you to create three-

dimensional models by building 2D sketches with specified parameters. The main

advantages of SolidWorks:

Parametric modeling. All changes to the model are made by editing the sketch
parameters. This allows you to easily modify the design by changing only the
numerical values of dimensions or the parameters of dependencies.

Intuitive interface. SolidWorks has a convenient command bar
(CommandManager) and a construction tree (FeatureManager Design Tree),
allowing you to quickly find the necessary tools.

Modular structure. The program consists of separate modules for working
with individual parts, assemblies, and drawings, which allows you to
systematize the project and facilitate the development process.

Build automation. Using tools like Circular Sketch Pattern, Mirror, Straight
Slot, Polygon and Trim Entities, significantly speeds up the creation of complex

sketches and ensures their accuracy.

3. Preparing the SolidWorks working environment

3.1 Creating a new document

. Start SolidWorks and select the New — Part command (Figure 1).



Fig. 1

. Go to the Options — Document menu. Properties — Units (Options —
Document Properties — Units) and set to millimeters (Fig. 2).

. Select a plane to create a sketch on, for example, Front Plane (Front plane)

(Fig. 3).

3.2 Setting up the workspace

Make sure that the feature tree (FeatureManager) correctly displays the
sequence of operations performed.

Adjust the view orientation (View Orientation) for ease of working on sketches

(isometric or front view).
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Document Properties - Units

System Options Document Properties

Drafting Standard Unit system
. Annotations O MKS [meter, kilogram, second)
Dimensions O CGS [cem_:lrrleter, gram, second)
Virtual Sh S (millimeter, gram, second] —~ifee———
- Virtual sharps IPS (inch, pound, second)
-Ta.bles (O Custom
- DimXpert
Detailing
i Type | Unit | Decimals | Fractions
[ Basic Units
odel Lisplay Length millimeters 12
Material Prqpertles Dual Dimension Length  |inches a2
Image Quality
Sheet Metal MED Angle degrees a2
Sheet Metal Mass/Section Properties
Weldments Length millimeters 12
Plane Display Mass grams
Configurations = —
Per Unit Volume millimeters* 3
Motion Units
Time second a2
Force newton =12
Power watt .12
Energy joule 12
Decimal rounding
@ Round half away from zero
ORound half towards zero
() Round half to even
OTruncatewithout rounding

Fig. 2

Fig. 3
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4. Creating an orthogonal projection of a flat membrane (2D sketch)

4.1 Developing a basic sketch

1. Starting a sketch:

On the selected plane (for example, Front Plane) click Sketch. The origin is

used as the base point for constructing symmetrical elements (Fig. 4).

Fig. 4

2. Construction of concentric circles:
o Use the Circle tool to create concentric circles.
o Through Smart Dimension (Dimensions) set the radii of the circles. The
centers of all circles must coincide with the Origin (using the Coincident

property).
12



3. Creating a cutting profile:
o Using tools such as Line, Arc, Circle, Polygon, Slot, etc., construct the
contour of the membrane cut (Fig. 4).
o Set dimensions via Smart Dimension and set geometric dependencies
(parallelism, perpendicularity, symmetry, coincidence, etc.) so that the
sketch is fully defined (Fig. 4).
o Use Trim Entities (Trimming) to remove unnecessary lines and curves

that are not part of the main contour (Fig. 5).

Fig. 5

4. Using tools for repeating elements:
o Circular Sketch Pattern (Circular Sketch Array): Use to reproduce
elements that repeat around a center. Specify the number of instances

(Figure 6).

Fig. 6
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o Mirror: Use to create symmetrical elements by specifying the centerline
through Origin.
o Straight Slot: Use to create straight slots with precise positioning and
dimensions (Fig. 7).
o Polygon: Use to construct elements with many sides if the task requires
it (Fig. 8).
5. Finishing the sketch: Make sure all sketch elements have their dimensions and

dependencies set, and click Exit Sketch.

Fig. 7 Fig. 8

14



5. Creating a 3D model of a flat membrane
5.1 Extrude Boss / Base (Extrusion)
1. Starting the extrusion operation:
o Go to the Features tab and select Extruded Boss / Base.
o In Property Manager (Properties Panel) in the Depth field, enter a value
of 10 mm and select the Blind option (Fig. 9).

Fig. 9

2. Converting a sketch into a 3D model:
o Click OK to complete the operation. A flat membrane model will be

created with a thickness of 10 mm (Fig. 10).

15



Fig. 10

3. Model control:
View the model in different views (Front, Top, [sometric) to verify the extrusion

1s correct. Make adjustments, if necessary, by returning to the sketch.

5.2 Adding Fillets
1. Starting the rounding operation:
o Inthe Features tab, sclect Fillet (Figure 11).
2. Setting rounding options:
o In the properties panel, enter a value of 2 mm for the Radius parameter
(Figure 11).
3. Applying rounding:
o Select the top and bottom edges of the 3D model where you want to create
a rounding (Fig. 11).
o Click OK to complete the operation, making sure that the rounding is

applied correctly.

16



Fig. 11

6. Creating a drawing of a membrane part

6.1 Drawing formation
1. Starting the drawing creation procedure:
o Use the File — Make command Drawing from Part (File — Create
drawing from part).
o Select a standard sheet (for example, A4 ISO format) and set the drawing

scale (1:1 or 1:2 - depending on requirements).

17



Fig. 12

2. Model view placement:
o Using Model View (Model View) insert the main views of the flat
membrane.
o Arrange the main views so that all structural elements are clearly visible.

o For example, you can create two views — Top View and Front View (Fig.

13).

6.2 Dimensioning
1. Dimensioning:

o Using Smart Dimension manually applies dimensions corresponding to
the main characteristics of the membrane (circle diameters, recess sizes,
slot parameters, polygons).

2. Alternative option:
o Use the Import Annotation — Design Annotation function to

automatically transfer dimensions from the model to the drawing (Figure

14).
18
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Fig. 14

3. Drawing check:
Make sure that the drawing contains all the necessary dimensions, text symbols,

center lines and save it in SolidWorks Drawing (SLDDRW) format (Fig. 15).

20



Fig. 15
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7. Report preparation
7.1 Report structure
The report should contain the following sections:
o Introduction:
A brief description of the purpose of the work, the tasks and the importance of
correctly constructing sketches as the basis of parametric modeling.
« Description of the construction stages:
o Detailed description of creating a sketch of a flat membrane with an
indication of the tools used (Circle, Line, Arc, Polygon, Circular Sketch
Pattern, Mirror, Straight Slot, Trim Entities).
o Description of converting a sketch into a 3D model using Extrude with
parameters: Depth = 10 mm, Blind.
o Description of the use of 2 mm radius fillets on the top and bottom edges.
« Drawing design:
o Procedure for creating a drawing using Make Drawing from Part and
dimensioning (via Smart Dimension or Import Annotation — Design

Annotation).

9. Recommendations and tips
1. Full certainty of the sketch:
Make sure that each sketch element has set dimensions and geometric
dependencies - this will avoid errors when applying the Extrude command.
2. Optimization of the construction of repeating elements:
Use Circular Sketch Pattern and Mirror to create symmetrical parts, which will
reduce modeling time.
3. Correct use of Extrude:
When setting the extrusion parameters, enter a value of 10 mm in the Depth
field in the Property Manager and select the Blind option.

4. Drawing design:

22



To create a drawing, use the Make command. Drawing from Part and apply
dimensions using Smart Dimension or automatic annotation transfer via Import
Annotation.

5. Regular check:

After each stage, check the model in different view modes (Front, Top,
Isometric) to detect possible errors in a timely manner.

10. Conclusion

The implementation of this laboratory work contributes to the acquisition of
practical skills in SolidWorks, in particular:

« Developing skills in constructing fully defined sketches using dimensions and
geometric relationships.

« Gaining the skills to create simple three-dimensional bodies through the Extrude
operation.

o Mastering methods for applying fillets.

« Creating a simple drawing of a part with accurate dimensions.

« Developing a report with a detailed description of the stages of work, analysis
of the results obtained, and recommendations for further improvement of
modeling skills.

Following these methodological guidelines will help students consolidate basic
practical skills in working with SolidWorks, which is the basis for successfully

completing more complex tasks in the field of computer modeling.
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Lab Work Ne3: Construction of a three-dimensional model and shaft

drawing in SolidWorks

Introduction
The purpose of the laboratory work is to master the process of modeling a three-
dimensional model of a shaft and creating its drawing in SolidWorks. A shaft is a key
part in mechanical engineering that transmits torque and supports rotating elements.
During the work, students will learn:
+ Create three-dimensional models of shafts with various structural elements.
o Use SolidWorks tools to build sketches and solid models.
o Generate drawings with views, sections, and annotations.
To complete the task, basic knowledge of the SolidWorks interface and the
basics of engineering graphics is required. Each student works with his own version

of the shaft, the parameters of which are specified in the individual task.

1. General requirements and preparation of the working environment
1.1 Starting the program and creating a part
— Start SolidWorks and create a new file in Part mode via the File > New >

Part menu.

Figure 1 — Creating a new file in Part mode

24



— Check the units’ settings via Options > Document Properties > Units and

make sure the correct units are used for your task (usually millimeters).

Document Properties - Units

System Options Document Properties

Drafting Standard Unit system
_. Annotations D MES [meter, kilogram, second]
I . D CGS5 [centimeter, gram, second)
- Dimensions .
Virtual Sh @ MMGS [millimeter, gram, second] —lj——————
rtual sharps (JIPS (inch, pound, second)
" Tables D Custom
B DimXpert
Detailing
Grid/Snap Type Unit Decimals Fractions Maore
Uniits| Basic Units
Model Display Length millimeters a2
Material F'ru:fperhes Dual Dimension Length  |inches a2
Image Cuality
Sheet Metal MED Angle degrees a2
Sheet Metal Mass/Section Properties
Weldments Length millimeters a2
Plane Display Mass qrams
Configurations - —
Per Unit Valume millimeters "3
Maotion Units
Time second a2
Force newton 12
Power watt 12
Energy joule 12

Figure 2 — Setting units of measurement

— Organize your workspace, create a separate folder to store project files, and

regularly save your work using the save function (Ctrl+S).

1.2 Preparing for modeling

Before starting the construction, pay attention to the geometry of the shaft, the
shapes of the segments, grooves, holes, the location of the keyway, as well as the
requirements for chamfers and fillets (an example of shaft geometry is shown in Figure
3). This will allow you to correctly plan the construction sequence and choose the

appropriate modeling method.

25



Figure 3 — Shaft geometry with required dimensions for modeling

2. Building a three-dimensional model of the shaft
There are two main methods for constructing a shaft model that a student can
use depending on the design features of the part and their own preferences. A detailed

description of each method is provided below.

2.1. Method 1: Constructing individual shaft segments using the Extruded
Boss/Base command

This approach is based on creating a separate sketch for each shaft segment. The
sketch directly reflects the desired shape — it can be not only a circle, but any closed
contour (rectangle, truncated circle, other geometric shape) that corresponds to the
drawing of the corresponding task variant. Thanks to this method, there is no need to
perform additional trimming operations if the sketch already forms a segment with the

desired geometry.
26



2.1.1. Creating individual segments

Selecting a plane for a sketch

Select one of the standard planes (for example, Front Plane) and create a new
sketch using the Sketch command.

Building a segment sketch

Using construction tools (e.g., Line, Circle, Rectangle, Arc, etc.), create a
closed path that matches the shape of the shaft segment according to the drawing
(Figure 4).

Set the necessary dimensions and relationships to make the sketch fully defined.
Make the sketch fully defined by adding the necessary dimensions and relationships
(Figure 4).

i
/

14,00

@50
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Figure 4 — Sketch of a shaft segment

Creating a 3D model of a shaft segment
After completing the sketch, click Exit Sketch and use the Extruded Boss/Base
command to extrude the sketch to a specified length (Figure 5).

27



Be sure to check the " Merge results " box, which will allow you to merge the

created volumes into one solid body (Fig. 5).

Figure 5 — Creating a 3D model of a shaft segment

2.1.2. Operations for forming structural elements

The main advantage of this method is that the sketch of each individual segment
defines the required geometry without the need for additional trimming operations to
achieve the desired shape. However, if the drawing requires a keyway, grooves, or

other features, these must be created separately (see Chapter 3).

2.2. Method 2: Constructing a shaft by rotating a sketch using the Revolved
Boss/Base command

This approach is more appropriate and rational for building shaft-type parts. It
consists in creating a single shaft profile consisting mainly of straight lines, as this
results in cylindrical segments. This profile is then rotated around a given axis using
the Revolved Boss/Base command.

The resulting body contains all the shaft segments, however, in cases where the

segment is not completely cylindrical, additional trimming operations must be applied.

28



2 .2.1. Creating a shaft sketch

Building an axis and a sketch

On the selected plane (for example, Front Plane), create a new sketch using the
Line tool to draw a centerline. Use dimensions and relationships to precisely position
this line.
Then, draw a closed path that describes the outer contour of the shaft, which consists
mainly of straight lines (except for the grooves, where fillets must be applied). This
will allow you to obtain cylindrical segments when rotating the profile (Figure 6).

Full definition of a sketch

Make the sketch fully defined by adding the necessary dimensions and
relationships (Figure 6). This will ensure the accuracy of the resulting geometry during

subsequent rotation.

45 40 65

18
17.75
16
18
25

210

Figure 6 — Shaft sketch

2.2.2. Rotation operation and shaft shape correction

Revolved Boss/Base Application

Once the sketch is complete, use the Revolved Boss/Base command to rotate
the profile around the axis. Set the rotation to 360° to obtain a full shaft body (Figure
7).

Shaft shape correction

In cases where the shaft segment, according to the drawing, is not cylindrical in
shape, it is necessary to apply additional cutting operations using the Extruded Cut

command to remove excess material (Fig. 8, 9).

29



This operation allows you to precisely adjust the shape of each segment

according to the requirements of the drawing.

Figure 7 — Using Revolved Boss/Base to obtain a shaft model
For example, if the drawing involves a cut contour on a certain segment, after

rotating the profile, it is necessary to apply the Extruded Cut command to remove

part of the shaft body and obtain the specified geometry (Fig. 8, 9).

Figure 8 — Creating a sketch for cutting  Figure 9 — Final view of the shaft after

cutting
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3. Construction of keyways, grooves, holes, chamfers and roundings
This section contains general recommendations for forming structural elements
that apply regardless of the chosen method of constructing the shaft model.
3.1. Construction of a keyway groove
There are two methods you can use to create a keyway in SolidWorks:
1. Using an auxiliary plane tangent to the cylindrical surface of the shaft segment.
2. Create a sketch in the Front Plane using the Offset command by a distance

equal to the radius of the corresponding segment.

3.1. 1 Method 1: Creating an auxiliary plane and building a sketch on it
Creating an auxiliary plane

— Use the Reference Geometry > Plane command to create a new plane.

— Position the plane so that it is tangent to the outer cylindrical surface of the

shaft segment where the keyway is to be located.

Figure 10 — Creating an auxiliary plane
31



Building a groove sketch
— On the created reference plane, sketch the keyway groove (Fig. 11).
— Use the Straight Slot command, which allows you to directly create the

desired slot shape.

Figure 11 — Construction of a sketch of a keyway

— Alternatively, you can create a rectangular contour and then use the Fillet
command to round off the required areas. However, it is most convenient to use

Straight Slot, as it immediately forms the required profile.

Figure 12 — Cutting a groove using Extruded Cut
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Forming a groove using Extruded Cut

— After completing the sketch, use the Extruded Cut command to cut the shaft
body to the specified keyway depth (Figure 12).

— Make sure that the direction of the cut coincides with the direction of the shaft

axis to ensure correct geometry.

3.1. 2 Method 2: Using the Offset command to position the sketch

Creating a sketch in the front plane

— Select the Front Plane and create a new sketch on it.

— Construct the contour of the keyway using the Straight Slot command or a
rectangle with subsequent rounding using Fillet (Fig. 13).

Sketch offset relative to shaft axis

— Use the Offset command to shift the sketch by a distance equal to the radius
of the corresponding shaft segment (Figure 13).

This will allow you to correctly position the groove without the need to create a

reference plane.

Figure 13 — Using the Offset command to create a groove

Forming a groove using Extruded Cut
— Apply the Extruded Cut command and set the depth of the cut according to
the drawing (Fig. 13).

33



— Make sure that the operation is performed to the required depth according to

the technical requirements.

Figure 14 — Final view of the keyway

Both methods ensure the correct formation of the keyway, and the choice

depends on the convenience and specifics of the construction of a particular shaft.

3.1.3 Selecting keyway sizes

To correctly create keyways in this laboratory work, students must use the

standard dimensions given in Table 1 according to DSTU GOST 24069:2005. The

table shows the recommended parameters of the grooves for different shaft diameters.

Table 1 — Shape and dimensions of prismatic keys (DSTU GOST 24069:2005)

Chamfer S | x45° or
_ Shaft Keyway Keyway radius r
Option ' '
diameter |cross-section
number
d bxh : max. minimum
bushings t
shaft t ;
2
1 22..30 8 x7 4.0 33 0.25 0.16
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Chamfer S ;| x45° or
_ Shaft Keyway Keyway radius r
Option
diameter |cross-section
number
d bxh . max. minimum
bushings t
shaft t
>
2 30...38 10 x 8 5.0 35 0.25 0.16
3 38...44 12x8 5.0 33 04 0.25
4 44...50 14 x9 5.5 3.8 04 0.25
5 50...58 16 x 10 6.0 4.3 04 0.25

Figure 15 — Drawings with designations of main dimensions (to Table 1)
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Keyway parameters
For each shaft diameter, the following are given (see Fig. 15 and Table 1):
o Key cross-section (bxh) — the width and height of the prismatic key.
o The depth of the groove in the shaft (t ;) is a recommended value.
o The depth of the groove in the sleeve (t ;) is a recommended value.
o Chamfer (S ;| X45°) or radius (r) — parameters for processing the edges of the
groove (recommended maximum and minimum values).
Determining the dimensions of the groove
— Before creating a groove, the student must determine the diameter of the
corresponding shaft segment.
— Select the appropriate values from table 1 for the key cross-section and groove
depth.
Creating a groove
— create a sketch of the groove according to the specified dimensions, and cut to
the appropriate depth using one of the methods described above.
Chamfering and rounding
— If the drawing provides for chamfers on the edges of the groove, use the
Chamfer command with the parameter S ; x45° specified in Table 1.
— If rounding is necessary, use the Fillet command, specifying the appropriate

radius r, the values of which are also given in Table 1.

3.2 Construction of grooves

Grooves on shafts are commonly used to accommodate retaining rings, O-rings,
or other components that require precise positioning. Creating them in a 3D model is
essential to meet technical requirements.

When creating grooves on a shaft, students should follow the standard
dimensions given in Table 2.

This data contains the parameters of the width, depth and radius of the grooves

in accordance with DSTU ISO 286-2:2002.
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The presented parameters ensure correct execution of the grooves according to

technical requirements and contribute to the accurate reproduction of the shaft

geometry in SolidWorks.
Table 2 — Grinding tolerance (DSTU ISO 286-2:2002)
b to execute  |[External Internal N d
T I'1
1;2 3 grindingd ;  |grinding d » ~
1 — 0.2 103 (0.2
d—0.3 d+0.3
1.6 — <10
0.5 0.3
2 — 0.3
d—0.5 d+0.5
3 1.5 1 > 10-50
0.5
5 2.25 0.5 |1.6 > 50-100
8 2.8 d-1 d+1 2
1 > 100
10 5.0 3

Note: When grinding several different diameters on the same part, it is

recommended to use grooves of the same size.

Figure 16 — Drawings with designations of the main dimensions of the grooves (to

Table 2)
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Methods for creating grooves in SolidWorks
There are two ways to create grooves that can be used depending on the method
of shaft construction:
1. Adding grooves to a general shaft sketch followed by using Revolved Cut
o If the shaft is created using the Revolved Boss/Base method , then the
grooves can be immediately provided in the overall shaft sketch.
o To do this, it is necessary to add notches to the sketch profile according

to the groove sizes given in the table (Fig. 17).

Figure 17 — Creating a groove profile in a general shaft sketch
o Once the sketch is complete, the Revolved Cut command is applied,

which cuts the grooves simultaneously with the formation of the

cylindrical shaft segments.
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Figure 18 — View of the groove in the three-dimensional shaft model

2. Creating grooves as a separate element

o If the shaft has already been created without grooves, they can be added
separately using a new sketch.

o Select a plane that passes through the shaft axis (for example, Front
Plane) and sketch the groove profile.

o Use the standard groove width, depth, and fillet dimensions listed in
Table 2.

o Once the sketch is complete, apply the Revolved Cut command, rotating

the profile around the shaft axis to create the groove.

Recommendations for constructing grooves

« Before creating a groove, determine the appropriate shaft segment diameter and
select the groove parameters from Table 2.

o If the drawing contains roundings, they should be made according to the radii r
and r | (see Fig. 16, 17 and Table 2).

« It is important to verify that after applying Revolved Cut, all elements remain

correct and meet the requirements of the drawing.
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Using standard sizes ensures compliance with technical standards and simplifies

the modeling process.

3.3 Creating cylindrical holes in a shaft model
If the shaft drawing contains cylindrical holes or cutouts (for example, through,
countersunk, threaded, or shaped), they must be accurately reproduced in the model,
adhering to the specified diameter and depth dimensions. There are three main
commands you can use to create such elements in SolidWorks:
1. Extruded Cut — for simple through or blind holes of cylindrical shape.
2. Revolved Cut — for shaped holes that have a variable diameter or rounding.
3. Hole Wizard — for standard threaded, countersunk, countersunk and shaped
holes.
Cutouts using Extruded Cut
This method is suitable for creating holes of simple geometry that have the same
diameter throughout the entire depth.
Construction process:
« Select the plane on which the hole will be located (for example, the end surface
of a shaft segment or the plane of symmetry).
« Sketch a circle that defines the diameter of the hole.
o Use the Extruded Cut command, specifying the required hole depth:
o For through holes, select Through All.
o For blind holes, set the depth manually according to the drawing.

o Make sure the hole size meets the drawing requirements.

Cutouts using Revolved Cut

If the drawing involves a shaped hole (for example, countersunk or stepped), it
is advisable to use the Revolved Cut command, which allows you to obtain a cut by
rotating the sketch around an axis.

Construction process:

« Select a plane that passes through the shaft axis (for example, Front Plane).
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« Create a sketch of the hole profile, accurately specifying diameters, depths, and
corner chamfers according to the drawing.
« Use the Revolved Cut command, specifying the axis of rotation.

o Make sure that the resulting geometry matches the drawing.

Holes using Hole Wizard
Hole Wizard command allows you to quickly create standard holes, including
threaded, countersunk, or blind holes for fasteners.

Construction process:

« Select the shaft surface on which you want to make a hole.

o Open the Hole Wizard menu and select the hole type (threaded, countersunk,
countersunk for screw, etc.).

o Specify the standard and hole size according to the drawing (e.g., metric thread
M8 x 1.25).

« Position the hole using dimensions or snaps.

« Apply the operation and verify the correctness of the resulting geometry.

The correct application of these methods guarantees that the 3D model
corresponds to the drawing and facilitates the subsequent preparation of technical

documentation.

3.4 Creating chamfers
Chamfers on shafts perform several important functions in mechanical
engineering and technology. The main purposes of chamfers are:
1. Easier assembly — chamfers help guide parts during assembly, especially when
installing bearings, keys, couplings, etc.
2. Reduce stress concentration — sharp transitions between cylindrical and flat
surfaces create areas of increased stress. Chamfers reduce the risk of cracking

and failure.
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3. Improved processing processability — when threading, grinding and turning,
chamfers make processing easier and reduce the risk of burrs.

4. Edge protection of parts — sharp edges can be easily damaged during
transportation or operation; chamfers help avoid such damage.

5. Improved lubrication — in some cases, chamfers contribute to better penetration

of lubricant into the joint.

Methods for creating chamfers in SolidWorks
To add chamfers in SolidWorks, you use the Chamfer command. There are
two main approaches to creating them:
1. Applying the Chamfer command to a finished shaft model is the most
convenient and fastest way.
2. Creating chamfers directly in the shaft sketch is an alternative option that

allows you to form a chamfer even at the stage of building the base geometry.

Creating chamfers on a finished shaft model
This method is the most convenient because it allows you to quickly add
chamfers after completing all the basic model construction.
Construction process:
« From the Features menu, sclect the Chamfer command.
« Select the edges or corners where you want to create a chamfer (Fig. 19).
« Specify the chamfer parameters according to the shaft drawing.
« Confirm the operation by clicking OK.

Chamfers created in this way can be easily modified or removed if necessary.
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Figure 19 — Specifying chamfer parameters using the Chamfer command

Creating chamfers in a shaft sketch
If the shaft is built using the Revolved Boss/Base method, chamfers can be
provided at the sketch stage using the Sketch Chamfer command .

Construction process:
o When sketching the main shaft profile, add chamfers in the appropriate places
using the Sketch Chamfer command (Fig. 20).

Figure 20 — Adding a chamfer to the main shaft profile sketch
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o In the Property Manager panel, specify the chamfer parameters according to
the shaft drawing (Fig. 20):
o Angle-Distance — specifies the chamfer length and angle (for example, 1
X 45°).
o Linear method (Distance-Distance) — two chamfer lengths are
determined.
o Complete the sketch and use the Revolved Boss/Base command to create a
solid model of the shaft.
This method provides automatic construction of chamfers along with the main

geometry, but they will be more difficult to modify if necessary.

3.5 Final shaft model

After completing all stages of construction, we obtain the final three-
dimensional model of the shaft, which contains all the necessary structural elements
according to the drawing (Fig. 21). In the process of work, the operations of creating
the basic geometry, adding grooves, slots, holes, as well as edge processing by adding
chamfers and roundings were implemented. All dimensions, shapes and parameters of
the elements are determined according to the task drawing, which ensures that the
model meets the technical requirements.

The resulting model is fully completed and can be used for further drawing
design, geometry compliance analysis, or other engineering calculations. Visual
representation of the model allows you to check the correctness of the constructions
and evaluate the overall appearance of the part before creating technical

documentation.
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Figure 21 — Three-dimensional shaft model

4. Creating a shaft drawing
After building a 3D model of the shaft, a technical drawing should be drawn up,

which contains all the necessary views, sections, and dimensions.

4.1 Preparing the drawing

Creating a drawing based on a model

After saving the 3D model, use the File > Make Drawing from Part option to
create a drawing that will automatically load the shaft model.

Select the desired sheet format (for example, A 3) and set the appropriate
drawing design standard.

Location of species

Place the main shaft views using the View Layout menu. Add auxiliary views,
Section Views, to show internal structural features such as keyways, chamfers, and
fillets.

When placing views, consider ease of reading the drawing, clarity of lines, and

compliance with the geometry of the model.
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4.2 Dimensioning

Dimensioning of shaft drawing

To apply dimensions, use the Smart Dimension command, which allows you
to manually specify all the necessary shaft geometry parameters, including diameters,
segment lengths, slot width, chamfer and fillet sizes.

Alternatively, you can use the Import Annotation — Design Annotation
function, which will allow you to automatically transfer dimensions from the model
to the drawing, provided that the elements are properly parametrically defined.

Correct placement of dimensions

Arrange dimensions in a way that they do not interfere with each other and are
clearly understood. All dimensions must correspond to the parameters specified in the

task drawing.

4.3 Hatching of sections

Hatching settings

To display sections, use the standard hatch type used in SolidWorks (for
example, Hatch ANSI 31). or another appropriate type set in the drawing template).

Make sure the rotation angle and hatch scale settings meet the requirements of

the drafter.

5. Recommendations for documentation

File organization

Save your 3D model and drawings in appropriate folders, using clear file names
that indicate the task variant. This will help maintain the sequence of work and make
it easier to find files later.

Documenting the process

It is recommended to include screenshots of key stages of construction in the
documentation — creation of sketches, command dialogs (Extruded Boss/Base,
Revolved Boss/Base, Extruded Cut, Straight Slot, Chamfer, Fillet), as well as the

final appearance of the model and drawing. Such documentation will contribute to a
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better understanding of the process and will help in further self-assessment of the
work.

Compliance with standards

The design of the drawing must comply with established state standards. Pay
attention to the correct arrangement of views, correct design and application of fonts,

scales, and hatching.

Figure 22 shows an example of a shaft drawing design.
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Figure 22 — Example of shaft drawing design
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Conclusion

While performing laboratory work on building a three-dimensional model and
creating a shaft drawing in SolidWorks, the student must:

* Create a three-dimensional model of the shaft with all components (grooves,
cutouts, keyways, chamfers, roundings, etc.);

» Create a technical drawing. Arrange the main views and auxiliary views,

including sections, to show the internal geometry of the shaft and structural elements.

Following these methodological guidelines will allow students to obtain a high-
quality three-dimensional model of the shaft and a corresponding drawing that meets
the requirements of the task.

Laboratory work will help develop parametric modeling skills, clearly define
sketches using dimensions and relationships, and correctly design technical
documentation in SolidWorks.

The knowledge gained will be useful for further work in CAD systems and

design activities.

49



Lab Work Ne4: Strength analysis of a part in SolidWorks Simulation
module

1. Introduction

Modern engineering design is impossible without the use of computer-aided
design (CAD) and computer-aided engineering (CAE) systems. The integration of
these systems allows not only to create accurate three-dimensional models of products,
but also to conduct virtual tests of their behavior under the influence of various loads
at the design stage. This significantly reduces development time, reduces the cost of
manufacturing physical prototypes and increases the reliability of the final product.

The SolidWorks software package contains a powerful built-in SolidWorks
Simulation module designed to perform various engineering calculations, including
structural strength analysis using the finite element method (FEM).

This laboratory work is aimed at students acquiring practical skills in creating
three-dimensional models of parts according to drawings and conducting their static
analysis for strength using SolidWorks and SolidWorks Simulation tools.

The purpose of the work is to acquire practical skills in creating three-
dimensional models of parts in the SolidWorks environment and conducting static
analysis of structural strength using the SolidWorks Simulation module to assess the
stress-strain state and safety factor.

Job objectives:

1. To get acquainted with the basic principles of performing strength
calculations using the finite element method in CAE systems.

2. Create a solid three-dimensional model of a part in SolidWorks according
to an individual task (drawing).

3. Perform a static strength calculation in the SolidWorks Simulation
module.

4. Analyze the results obtained: stress diagrams (according to Mises),
displacements, and safety factor.

5. Make a report on the work performed.
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1 Brief theoretical information

1.1 Basics of strength calculations using CAD/CAE systems

Engineering analysis (CAE — Computer-Aided Engineering) is an integral part
of the product development process. The use of CAE systems integrated with CAD
systems allows you to model the behavior of structures under the influence of
operational loads, analyze thermal processes, flows of liquids and gases, and optimize
structures according to various criteria.

Strength analysis is one of the most important types of engineering analysis. Its
main purpose is to determine whether a structure can withstand the loads applied to it
without failure or unacceptable deformation.

The basis of most modern CAE systems, including SolidWorks Simulation, is
the finite element method (FEM — Finite Element Method). Element Method). The
essence of the method is that a complex geometric model of a part (a solid body) is
divided into a large number of simple elements (finite elements - triangles, tetrahedra,
etc.), which are interconnected at nodes.

For each finite element, equations are written that describe its behavior under
load (based on the theory of elasticity, Hooke's law, etc.). These equations are then
combined into a single system of equations for the entire model. Solving this system
allows us to determine the main parameters of the stress-strain state at each node and
element of the mesh:

o Stress: Internal forces that arise in a material under the action of external loads
(measured in Pa or psi). The most common analysis is the Mises equivalent
stress, which is compared to the yield strength of the material.

« Displacement: change in the position of points in a structure under the action of
loads.

« Deformations: relative changes in the dimensions of structural elements.

« Safety factor (FOS — Factor of Safety): the ratio of the allowable stress (usually
the yield strength or tensile strength of the material) to the maximum design
stress in the structure. It shows how many times the applied loads are less than

those that can cause failure or plastic deformation. The structure is considered
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strong if the minimum SSR is greater than unity (in practice, a standard value is

chosen, for example, 1.5; 2; 3 or more, depending on the reliability

requirements).

1.2 Stages of conducting engineering analysis in SolidWorks Simulation

The process of performing a strength calculation in SolidWorks Simulation

includes the following main stages:

1. Preprocessing (Preprocessing):

[0}

[0}

Create or import a geometric model of a part (CAD).

Create a new study (Study) and select an analysis type (for example,
Static).

Assigning physical and mechanical properties of the part material
(Young's modulus, Poisson's ratio, yield strength, etc.). SolidWorks has
a large library of standard materials.

Setting boundary conditions: fixing certain faces, edges, or vertices of the
model to simulate its fixation (Fixtures).

Application of external loads: forces, pressures, moments, gravity, etc.
(External Loads).

Meshing: Breaking the model into finite elements. The quality of the

mesh significantly affects the accuracy of the results.

2. Solving:

o

Run the calculation (Run). The program automatically generates and

solves the system of equations of the MFE.

3. Postprocessing (Postprocessing):

o

Analysis and visualization of results. SolidWorks Simulation allows you
to display results in the form of color plots (graphs) of the distribution of
stresses, displacements, strains, and safety factor over the volume or
surface of the model.

Obtaining numerical values at specific points or areas.

Creating reports.
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2 Procedure for performing the work
2.1 Creating a three-dimensional model of a part

. Receive an individual task in the form of a detail drawing.

. Carefully study the drawings, identify the basic elements and sequence of
modeling operations.

. Launch the SolidWorks application.

. Create a new document of type Part: File - > New -> Part - > OK.

. Using the tools in the Features and Sketch panels, sequentially create a three -

dimensional model of the part (Fig. 1).

Figure 1 — Three-dimensional model of the part

Basic tools you may need:
o Extruded Body/Base Boss / Base): creating volume by extruding a sketch.
o Revolved Body/Base Boss / Base): creating bodies of revolution.
o Extruded Cutout Cut): Remove material by extruding the sketch.
o Revolved Cutout Cut): removes material by rotating the sketch around an

axis.
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Mounting hole (Hole Wizard): creating standard holes (threaded, bolt
holes, etc.).

Fillet: creating fillets on edges.

Chamfer: creating bevels on edges.

Mirror: creating symmetrical elements.

Arrays Linear Pattern, Circular Pattern: creating arrays of elements.

6. Make sure that the geometric dimensions of the model exactly match the

drawing. Use the Measure tool on the Evaluate tab to control the dimensions.

7. Save the created part model in your working folder: File - > Save As ... As ...).

Give the file a meaningful name (for example, Detail Variant XX.SLDPRT ).

2.2 Activating the SolidWorks Simulation module

Before starting the calculation, you must make sure that the SolidWorks

Simulation application is activated.

1.
2.
3.

Go to the Tools - > Add -Ins ... menu.

In the window that appears, find SolidWorks Simulation in the list (Fig. 2).

Check the boxes next to SolidWorks Simulation in the left column (to activate

in the current session) and, optionally, in the right column (to load automatically

when SolidWorks starts) (Fig. 2).

. Click OK.

the Simulation tab will appear in the CommandManager (toolbar).
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Figure 2 — Activating the SolidWorks Simulation module

Figure 3 — Simulation tab in CommandManager

2.3 Creating a new static analysis study

. Go to the Simulation tab in the CommandManager (Figure 3).

. Click the New Study button (New Study) (Fig. 3).

. In the PropertyManager (property pane on the left), under General Modeling
(General Simulation) select the Static study type (Fig. 4).

. Optionally, change the study name (default is " Static 1") to more informative.
. Click the green checkmark (OK) to confirm the creation of the study.

. in the Simulation study tree (located below the FeatureManager design tree) (see

Figure 5).
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Figure 4 — Creating a new study Figure 5 — Simulation research tree

2.4 Applying material to the model
To perform the calculation, it is necessary to specify the physical and
mechanical properties of the material from which the part is made.
1. Inthe Simulation study tree, right-click the part icon (usually has the same name

as the part file) and select Apply / Edit Material. Material) (Fig. 6).

56



Figure 6 — Applying material to the model

2. The SolidWorks Material Library window opens.
3. Choose the material according to the task or as directed by the teacher.
Frequently used materials:
o Steel: Plain carbon steel Carbon Steel), Alloy steel (Alloy Steel)
o Aluminum alloys (Aluminum Alloys): 1060 Alloy (1060 Alloy)

o Others (copper, titanium, plastics, etc.).

57



Material *

Search... C)\ Properties  Tables & Curves Appearance CrossHatch  Custom  Application Data | 4 *

Material properties
Materials in the default library can not be edited. You must first copy the material

J—
— A
= 4286 Iron Base Superalloy to a custom library to edit it

SE AIS1 1010 Steel, hot rolled bar

$= AISI 1015 Steel, Cold Drawn [55) e ¥| savemodeliype inlibrary
$= wisi 1020 51 - N/m*2 (Pal -

$= AISI 1020 Steel, Cold Rolled Steel

S AlIsI 1035 Steel (55) o

SE AIS] 1045 Steel, cold drawn
o Max von Mises Stress
o= AISI 304

%E AlSI 316 Annealed Stainless Steel Bar

%E AISI 316 Stainless Steel Sheet [55)

%E AIS1 321 Annealed Stainless Steel [S5)

i Defined

9= AISI 347 Annealed 5tainless 5teel [35]

SE Al51 4130 Steel, annealed at 865C Property Value Units "

SE Al51 4130 Steel, normalized at 870C Elastic Maodulus 2.7e+11 MN/m*2

SE AlS| 4340 Steel, annealed Poisson’s Ratio 0.28 N/A

8= AIsl 4340 Steel, normalized Shear Modulus 7.9e+10  |N/m*2

8= wISI Type 316L stainless steel RS DG ey (G s

— Tensile St h 723825600 a2

8= WISl Type A2 Tool Steel ensile Strengt i

O— Compressive Strength M/m*2

o— Alloy Steel

o Yield Strength 620422000 N/m*2

== Alloy Steel (55

;: oy Steel (53) Thermal Expansion Coefficient |1.3e-05 /K
. S ASTM A36 Steel . ¥ [Thermal Conductivity 50 W/imK) .

Add... Save Config... Appl Cl Hel

SOLIDWORKS Materials Web Portal : S ose e

Figure 7 — SolidWorks Material Library Window

4. After selecting a material, its properties (Modulus of Elasticity, Poisson's Ratio,
Yield Strength, Density, etc.) will be displayed on the right side of the window
(Fig. 7). Make sure that the main properties required for static analysis (in
particular, Yield Strength - Yield strength), given.

5. Click Apply, and then Close.

6. In the research tree, a green check mark and the name of the assigned material

will appear next to the part name.

2.5 Setting boundary conditions (fixes)
Boundary conditions determine how a part interacts with its environment, i.e.,
which parts of it are stationary or have limited freedom of movement.
1. In the Simulation study tree, right-click the Fixtures folder and select Fixed

Geometry or another fixture type that meets the requirements of the problem
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(for example, Roller/Slider to allow movement along a plane, Fixed Hinge to

fix cylindrical faces) (Fig. 8).

Figure 8 — Setting the part fastening condition

2. Fixed Geometry: This type of fixture completely prohibits any movement or

rotation for the selected faces, edges, or vertices. In the PropertyManager:

o Inthe blue box, Faces, Edges, Vertices for Fastening (Faces, Edges, Vertices for
Fixture) select those faces (or other objects) of the model that should be fixed.
The selected objects will be highlighted in the graphics window and added to
the list (Fig. 9).
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Figure 9 — Selecting a face for fixing a part

o Review the fastener symbols that will appear on the model (Fig. 9).
o Click the green check mark (OK).
3. Specify all necessary fasteners according to the part fastening scheme in the real

structure or as instructed by the instructor.

2.6 Load specification
Loads are external influences acting on a part (forces, pressures, moments,
temperature, gravity, etc.).
1. In the Simulation study tree, right-click the External Loads folder. Loads) (Fig.
10).
2. Select the load type that best suits your application. The most common ones for
static analysis are:
o Force: Applying a concentrated or distributed force to faces, edges, or
vertices.

o Pressure: Applies pressure evenly distributed across the selected face(s).
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o Gravity: Takes into account the effect of the part 's own weight (you must
specify the direction of gravity).
o Torque: Applying torque to cylindrical faces.

Figure 10 — Load assignment

3. Example of setting Force (Force)
o Select Force (Fig. 11).
o In the PropertyManager:
= Inthe Selection section, select the faces, edges, or vertices to which
the force is applied (Fig. 11).
= Choose the direction of the force. You can do this:
» By selecting the Normal option (Normal to) and specifying

the face (the force will be perpendicular to it).
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Figure 11 — Selecting a face for applying force and setting its value

» Selected direction option direction) and specifying a plane,
axis, or edge to define the direction of the force. You may
need to specify the force components along the X, Y, Z axes.

= Activate the Reverse option. direction) if needed.

» In the Force section, enter the numerical value of the force in the
appropriate units (N, kgf, 1bf).
Make sure the correct unit system is selected (SI, English, etc.) (Fig. 11).
= Click the green check mark (OK).
4. Assign all necessary loads according to the individual task or the teacher's

instructions. Pay attention to the magnitude, direction, and location of the loads.
2.7 Creating a finite element mesh

Dividing the model into finite elements (tetrahedra for three-dimensional

models) is an important step in MFE.
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1. Inthe Simulation study tree, right-click the Mesh folder and select Create Mesh.
Mesh).

Figure 12 — Creating a calculation grid

2. The Grid Settings PropertyManager opens.
3. For the first calculation, you can leave the default settings:

o Mesh density (Mesh Density: The slider is usually in the middle,
providing a balance between accuracy and calculation time. Moving the
slider to the right (Fine) creates a finer (more accurate, but more resource-
intensive) mesh, to the left (Coarse) creates a coarser one.

o Mesh parameters (Mesh Parameters: You can leave Standard mesh or
Curvature based mesh. based mesh) (recommended for models with

complex geometry).

63



=)

Mesh
W ¥

Definition | Mesh Cuality

Mesh Density e

& ]

Coarse Fine
Reset

Issue warning for distorted
elements

Mesh Parameters ~
Cl Blended curvature-based mesh
l:::llfur-.rature-based mesh

@ Standard mesh

E mim A
% £.958445947mm =
TR NIRRT T 1]
JA | 0.34792247mm w s
II.lJIIIIIIIIIIIIIIIIImI,I

DAutnmatictransitinn

Advanced b

Figure 13 — Setting the calculation grid parameters

4. Click the green checkmark (OK). The program will automatically build the
mesh. The build time depends on the complexity of the model and the selected
mesh density.

5. After construction, the mesh will be displayed on the model (see Fig. 14).
Visually assess the quality of the mesh. It should be sufficiently fine in places
of stress concentration (holes, fillets, places of force application), but can be
coarser in less loaded areas.

Note: If the calculation results are inaccurate or convergence problems occur, it
may be necessary to refine the mesh (reduce the size of the elements globally or locally

using the Mesh control tools). Control).
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Figure 14 — Model of a part with a constructed finite element mesh

2.8 Starting the calculation
After the material, fasteners, loads have been specified and the mesh has been
created, you can start the calculation.

1. Inthe Simulation study tree, right-click on the study name (for example, " Static
1") (Figure 15).

2. In the context menu, select Run (Fig. 15).

3. solver status window will display the progress. The calculation time depends on
the number of mesh elements, the complexity of the problem, and the power of

the computer (Figure 16).
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Figure 15 — Starting the calculation
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Figure 16 — Solver Status Window

4. After the calculation is successfully completed, the status window will close,

and the Results folder with typical plots will appear in the study tree.

2.9 Analysis of results
, SolidWorks Simulation automatically creates several standard results plots that

appear in the Results folder: "



o Stressl: Usually shows the von Mises equivalent stresses (von Mises Stress).
o Displacementl: Shows the resulting displacements (Resultant Displacement).

« Strainl: Shows equivalent strains.

Figure 17 — Results in the research tree

To view any of these graphs, double-click on it in the study tree. The model will
be colored according to the parameter values, and a scale (legend) with the

corresponding numerical values will appear next to it.

2.9.1 Stress analysis

1. Activate the Stress1 (- vonMises -) graph.

2. Examine the stress distribution across the model. Pay attention to the areas with
maximum values (usually marked in red on the default scale). These are the
areas of stress concentration that are most dangerous from a strength

perspective.
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3. Find the maximum stress value on the scale. Compare this value with the yield
strength (Yield strength) of the material, which is indicated on the scale by a red
arrow (see Fig. 18).

o If the maximum stress is less than the yield stress, the part will not
undergo plastic (irreversible) deformation under a given load.
o Ifthe maximum stress exceeds the yield strength, plastic deformation will

occur in this zone, which may be unacceptable.

Figure 18 — Mises stress diagram

Analysis tools:

« Probe: Allows you to find out the exact value of the result at a selected point or
grid node. Right-click on the results graph -> Probe.

o Chart settings (Chart Options): Allows you to change the display of the scale,

units of measurement, etc. (Right mouse button on the graph -> Graph settings).
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« Definition parameters: Allows you to change the type of displayed stresses (e.g.,
principal stresses, normal stresses along the axes), units of measurement (Right

mouse button on the graph -> Edit definition (Edit Definition)).

Figure 19 — Analysis tools

2.9.2 Movement analysis

1. Activate the Displacement] graph (- Res disp -).

2. Study how the part deforms under load. The areas of maximum displacement
are marked in red.

3. Find the maximum displacement on the scale. Assess whether this displacement
1s acceptable for normal operation of the structure.

4. To see a deformed view of the model (usually the displacements are visually
magnified for clarity), right-click on the graph -> Edit Definition (Edit
Definition -> Definition Options - > Select Deformed Shape Shape). You can

adjust the scale of the deformatioel_)lé



5. , right-click on the graph - > Animate.

Figure 20 — Example of a displacement diagram

2.9.3 Safety Factor Analysis (SFRA)
Safety factor (Factor of Safety - FOS) is a key indicator for assessing the
reliability of the structure.
1. In the study tree, right-click the Results folder and select Define Safety Factor
Plot. Factor of Safety Plot) (Fig. 21).
2. The PropertyManager opens. In Step 1 of 3: Component Selection (Step 1 of 3:
Component selection):
o Select All to analyze the entire part.
o Click Next.
3. In the Step 2 of 3: Criteria section:
o Select the failure criterion. For ductile materials (steel, aluminum) the
Max. von Mises stress (Max from Mises Stress).
o The program will automatically substitute the value of the material's yield
strength in the Yield strength field (Yield strength). Make sure the units

of measurement are correct.
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o Click Next.
4. In Step 3 of 3: Factor Results (Step 3 of 3: Factor of safety results):

o Select the Factor Distribution option. of safety distribution).

o Click the green check mark (OK).

Figure 21 — Selection of the safety factor graph in the research tree
5. A graph of the distribution of CPM according to the model will be created (see

Fig. 22). The areas with the lowest CPM (most dangerous) will be marked in
red (by default).
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Figure 22 — Distribution of safety factor by model

6. Find the minimum CPM value on the scale or using the Probe tool.
7. Compare the minimum CBM with the standard (permissible) value for this type
of structure (usually > 1, often 1.5...3 or more).
o If the minimum CBM is greater than the allowable one, the structure is
considered strong.
o If the minimum CBM is less than the permissible one, the structure does
not meet the strength requirements and requires refinement (change in

geometry, material, reduction of loads).

2.10 Creating a report using SolidWorks Simulation
After running a calculation and analyzing the main results, SolidWorks
Simulation automatically generates a report that includes key information about the
model, study settings, and results. This can significantly speed up the documentation
process.
1. Running the report creation command:
o Go to the Simulation tab in the CommandManager.

o Click the Report button.
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Figure 23 — Report creation command in Simulation CommandManager

2. Configuring report content:
o Report window will open. options, where you can customize the content
of the future report.
o You can usually choose which sections to include in the report:
»  Model information (Model information)
= Study properties (Study properties)
= Units of measurement (Units)
= Material properties (Material properties)
» Loads and fastenings and Fixtures
= Contact information (if any)
= Mesh information (Mesh information)
= Assumptions
= Results plots) - you can choose which plots to include.
» Conclusion
= Appendix
o You can add your own sections, comments, images (for example,
additional screenshots of specific settings or model views).

o You can specify information about the author, company, logo, etc.
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Report Options ped

Current report format:  Static Study Format

Report sections: Section properties

Description P Section name:
DAssumptions |
Model Information
Study Properties
[+] Units

Material Properties
Loads and Fixtures
[] connector Definitions [linclude beam stresses At Joints
D Interaction Information
Mesh information [include beam forces Pp——

[] sensor Details
[T

|:|Comments:

Header information
Designer: | Petrenko lvan |

[ company: | NTU “KPI| |
[ uRL:

[roge:

[] Address:

|:|Phc|r1e: |:| Fa:

Report publish options

Report path: |Jser‘-,Desktop |

Document name: | Part1-5tatic 1-1 |

Paper size: (®) Letter 8.5 x 117 () A4(8.27" x 11,697
Show report on publish

Publish Apply Cancel Help

Figure 24 — Configuring report content

3. Format selection and publication:
o Select the desired report format (usually Microsoft Word Document *.
docx).
o Specify the save path and file name for the report.
o Click the Publish button. SolidWorks Simulation will automatically
collect the data and generate a report document (Figure 25).
4. Using the generated report:
o The automatically generated report contains structured information and
basic results plots (Fig. 26).
o It can be used as the basis for the final report required under Section 6 of

these guidelines.
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Figure 25 — First page of the report (Report)

Figure 26 — Example of presenting results in a generated report
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Important: An automated report typically requires editing, formatting, and
adding your own detailed analysis of the results, conclusions, and other information
required by the task and the "Report Requirements" section. It does not replace the

need for independent analysis and interpretation of the data received.

3 Description of task options
Each student receives an option number from the teacher.
The task includes:

1. A drawing or sketch of the part with the main dimensions. Missing dimensions
(for example, chamfers, roundings, if not specified) can be chosen by the student
constructively or in agreement with the teacher.

2. Basic conditions for calculation:

o Material: If the material is not explicitly stated, select a typical structural
material (e.g., Plain Carbon Steel). Carbon Steel) or Alloy steel (Alloy
Steel)).

o Fixing: Determine independently, based on the design of the part and its
likely use, or as directed by the instructor (e.g., fix one of the end surfaces,
mounting holes, etc.).

o Load: Determine the type, magnitude, and location of load application as
instructed by the instructor or based on an analysis of possible operating
conditions of the part (for example, applying force to a specific surface,
pressure on an internal cavity, etc.).

The student must:

1. Create a three-dimensional model of the part of your variant in SolidWorks.

2. Perform a static strength calculation in SolidWorks Simulation, specifying the
selected material, specified fastening conditions, and loading.

3. Analyze the results (stress, displacement, CBM).

4 Report requirements
The report on the performance of laboratory work is drawn up on A4 sheets and

must contain:
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. Title page (according to the established form).
. The purpose of the work and the individual task (variant number, image (sketch)
of the part).
. A brief description of the sequence of creating a 3D model of a part (main tools
and operations used).
. Description of study settings in SolidWorks Simulation:
o Study type (Static).
o Selected material and its main properties (yield strength).
o Schematic representation of the model with indicated anchoring zones
(boundary conditions).
o Schematic representation of the model with indicated applied loads (type,
magnitude, direction, location of application).
o Image of a finite element mesh (general view).
. Calculation results in the form of screenshots of diagrams (graphs) with
corresponding scales:
o Mises equivalent stress diagram (with maximum value and yield stress
indicated).
o Plot of total displacements (with maximum value indicated).
o Safety factor diagram (with minimum value indicated).
. Analysis of results:
o Estimation of maximum stresses (comparison with yield strength).
o Assessment of maximum displacements (whether they are permissible).
o Estimate the minimum safety factor (comparison with the permissible
value, for example, [KZM] = 1.5 or other as indicated).
. Conclusions regarding the strength and stiffness of the part under given
conditions. Does the design meet the strength requirements? If not, possible

ways to improve it.
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8.
9.

Check questions

. What are CAE systems and what are their advantages when used together with

CAD?

. What is the essence of the finite element method (FEM)?

. What are the main stages of the strength calculation process in SolidWorks?

Simulation (preprocessing, solution, postprocessing)?

. How do I activate the SolidWorks Simulation module?
. How do I create a new static analysis study?

. How do I assign a material to a part in Simulation and what material properties

are key for static strength analysis?

. What are boundary conditions (fixes) and how to specify them? Give examples

of types of fixes.
What types of loads can be specified in static analysis?

What is a finite element mesh and why is it needed? How to create a mesh?

10.How to run a strength calculation?

11.What are the main results of static strength analysis?

12.What does the von Mises stress diagram show? How to interpret it?

13.What does the displacement diagram show?

14.What is a safety factor (SFF)? How to calculate it and create a corresponding

graph?

15.What minimum value of the CBM is usually considered acceptable to ensure

structural strength?

16.What to do if the calculation shows that the maximum stresses exceed the yield

strength or the CSM is insufficient?
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Laboratory Work Assignments



Assignments for Laboratory Work No. 1
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Assignments for Laboratory Work No. 2
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Assignments for Laboratory Work No. 3
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Assignments for Laboratory Work No. 4

Assignment |
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1023 Carbon Steel Sheet (SS)
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Assignment 3
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AIST 1035 Steel (SS)
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Assignment 4

Static
AIST 304
500 H
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Assignment 5

Static
Alloy Steel
1300 H
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Assignment 6
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Alloy Steel (SS)
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Assignment 7
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Static
Galvanized Steel

700 H
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Assignment 8

Static
Plain Carbon Steel

480 H
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Assignment 9

45

Static
Stainless Steel (ferritic)

300 H
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Assignment 10

Static
Cast Alloy Steel
600 H

110

\/



Assignment 11

Static
Cast Carbon Steel

1000 H
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Assignment 12
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Ductile Iron

1200 H
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Assignment 13
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Assignment 14

Static
1060-H12
50H

114



Assignment 15

Static
1060-H14
150 H

115



Assignment 16
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1060-H16
380 H
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Assignment 17
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Assignment 18
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1345 Alloy
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Assignment 19
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700 H
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Assignment 20

Static
Aluminum Bronze

800 H
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FOR NOTES
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